
Le MSA en Analyseur de Spectre
Introduction

Ce guide est destiné à servir de référence dans l'utilisation du MSA en analyseur de spectre. De 
nombreuses  procédures  décrites  ici  s'appliqueront  également  à  l'utilisation  du  MSA en  tant 
qu'analyseur de réseaux vectoriel. On peut atteindre les pages soit en cliquant sur les titres en 
bleu ci-dessous, soit en utilisant l'onglet des signets.

Le  premier  chapitre  décrit  les  procédés  permettant  d'effectuer  des  analyses  et  de  créer  et 
manipuler des données graphiques :

Dispositif de mesure (1G) – Mise en œuvre pour la bande 1G (0 - 1000 MHz)

Dispositif de mesure (2G) – Mise en œuvre pour la bande 2G (1 – 2 GHz)

Dispositif de mesure (3G) – Mise en œuvre pour la bande 3G (2 – 3 GHz)

Premier balayage – Mise en œuvre pour l'exécution d'un balayage

Marqueurs – Placer et utiliser les marqueurs.

Aspect des graphiques – Personnaliser l'aspect des graphiques.

Fichiers préférences – Sauver et charger les fichiers préférences

Lignes de référence – Créer des lignes de référence

Le chapitre suivant décrit les procédés permettant d'exécuter certaines tâches particulières :

Générateur de tracking – Utilisation du mode Générateur de Tracking du MSA

Observation des harmoniques – Comment visualiser une fondamentale et ses harmoniques 
sans en manquer aucune.

Attention ! La fenêtre graphique du MSA peut être r edimensionnée, mais à condition de 
stopper le balayage d'abord. En raison d'un bug de Liberty Basic, le non-respect de cette 
condition risque de provoquer le plantage du progra mme.



Dispositif de mesure (1G)
Bande de fréquences 1G (0-1000 MHz)

La  sortie  « Générateur  de  Tracking »  ou  générateur  de  signal  (TG  /  Sig  Gen)  peut, 
accessoirement,  être  utilisée  comme  source  de  signal.  L'isolateur,  le  filtre  passe-bas  et 
l'atténuateur sont optionnels et présentent les avantages suivants :

DC Block (Isolateur)  : il s'agit d'un condensateur de grande qualité qui empêche toute tension 
continue d'atteindre le mélangeur d'entrée, ce qui l'endommagerait à coup sûr.

Atténuateur  : la précision de l'analyseur de spectre dépend de l'impédance de sortie de la source 
de signal, qui doit être proche de 50 ohms. L'atténuateur peut être vu comme faisant partie de 
cette source, aidant ainsi à remplir cette condition. La valeur de l'atténuation doit, bien sûr, être 
ajoutée à la lecture faite sur le MSA pour obtenir le niveau réel du signal. L'atténuateur protège 
également l'entrée d'une surtension ou de l'application accidentelle d'une tension continue.

Filtre  passe-bas  :  un  signal  d'entrée  de  fréquence  proche  de ou  même égale  à  celle  de  la 
première FI peut être interprété comme un signal sur lequel le MSA serait accordé. De plus, des 
signaux entre 2 et 3 GHz peuvent se mélanger avec LO1 (premier oscillateur local) de la même 
façon que des signaux entre 0 et 1 GHz, et être pris pour des signaux dans cette bande. C'est 
pour éviter cela que l'on insère un filtre passe-bas de fréquence de coupure proche de 950 MHz, 
comportant éventuellement une « trappe » à la fréquence de la première FI.



Dispositif de mesure (2G)
Bande de fréquences 2G (1-2 GHz)

L'isolateur et l'atténuateur  remplissent les mêmes fonctions que dans la bande 1G.

Le filtre passe-bas  n'est utilisé, si nécessaire, que pour bloquer les signaux voisins de 10,7 MHz.

Une modification de câblage est également nécessaire pour activer le mode 2G. Il faut connecter 
la sortie du premier mélangeur (Mixer 1) directement à l'amplificateur IF2.

Notez que lorsqu'on utilise la bande 2G en mode analyseur de spectre, chaque signal produit deux 
images, séparées par deux fois la fréquence IF2 (valeur de la deuxième fréquence intermédiaire). 
Elle  conviendra donc surtout  à  l'observation  d'un  signal  unique,  ou de signaux multiples dont 
l'espacement ne risquera pas de créer des images superposées.



Dispositif de mesure (3G)
Bande de fréquences 3G (2-3 GHz)

L'isolateur et l'atténuateur  remplissent les mêmes fonctions que dans la bande 1G.

Le filtre passe-haut  remplace le filtre passe-bas de la bande 1G. Son rôle est de bloquer les 
signaux  en-dessous  d'à  peu  près  1050  MHz,  de  façon  à  éliminer  aussi  bien  les  fréquences 
proches de celle de la première FI que toutes celles de la bande 0 – 1 GHz qui pourraient être 
vues comme appartenant à la bande 2 – 3 GHz.



Effectuer une analyse de base

Le  MSA effectue une analyse en  mesurant  à  des  fréquences  précises  dans  la  bande 
spécifiée et en observant un délai d'attente donné entre deux mesures. Les réglages qui contrôlent 
l'analyse se trouvent dans la fenêtre « Sweep parameters » (paramètres de balayage), que l'on 
ouvre :

– en double-cliquant juste en-dessous des étiquettes de l'axe des fréquences,
– en   double-cliquant  dans  la  zone  d'information  de  configuration  dans  la  partie 

supérieure droite de la fenêtre graphique
– par le menu « Options Sweep » (Options de balayage).

Les réglages nécessaires à l'analyse sont les suivants :

1. Filtre  de  résolution  et     bande  passante  du  filtre  video  .  Configuration  effectuée  par  des 
commutateurs matériels.

2. Plage d'analyse  . Indiquer, au choix, la fréquence centrale et la largeur de bande, ou bien 
les fréquences de début et de fin de balayage.

3. Balayage linéaire ou logarithmique  . Cochez la case qui convient. Si la bande observée est 
étroite, le balayage sera toujours linéaire.

4. Nombre de pas par balayage  . (nSteps est le nombre de pas). La bande de fréquences est 
divisée en nSteps pas,  ce qui implique nSteps+1 mesures. Plus le nombre de pas est 
grand, plus ils sont petits. En mode Analyseur de Spectre, si la taille des pas est supérieure 
à la bande passante du filtre de résolution, il est possible de rater un signal placé entre 
deux pas.

5. Délai d'attente (ms)  . Le MSA observera ce temps d'attente entre deux mesures. En mode 
Analyseur  de  spectre,  le  temps  d'attente  peut  être  nul  si  le  filtre  video  est  réglé  sur 
« Wide »  (large),  plus  long  si  le  réglage  est  « Mid »  (Moyen),  ou  plus  encore  s'il  est 
« Narrow » (étroit).

6. Direction du balayage  . Normalement de gauche à droite (L-R), mais on peut balayer de 
droite à gauche (R-L) ou de manière alternée (Alternate).

7. Gamme  . Réglée normalement sur 1 GHz. Les gammes supérieures sont expérimentales.

8. Rafraîchissement  après  chaque  balayage  .  Si  cette  case  est  cochée,  la  courbe  est 
redessinée après chaque balayage. La position des marqueurs est ainsi remise à jour, et 
cela  évite  certains  artefacts  d'affichage  constatés  lorsque  le  rafraîchissement  est 
permanent. Mais cela provoque un clignotement à la fin de chaque passage.

Pour  effectuer  un  balayage,  cliquer  sur  Restart.  Ce bouton deviendra Halt,  que vous pourrez 
cliquer pour arrêter le balayage. Vous pouvez reprendre le balayage en cliquant sur Continue, ou 
bien balayer seulement le pas suivant en cliquant sur One Step. Cliquer sur Redraw redessine le 
graphe, ce qui est quelquefois nécessaire.



Marqueurs

Pour placer un marqueur sur le graphe, choisissez-le dans la boîte et double-cliquez sur le graphe 
à la  fréquence souhaitée.  S'il  n'y a pas de marqueur  dans la  boîte  (« None »),  le  double-clic 
placera le marqueur L qui deviendra le marqueur courant. Sélectionner le marqueur courant dans 
la boîte et double-cliquer sur le graphe le repositionne.

Lorsqu'un marqueur est sélectionné, il peut être effacé par le bouton  Delete. Sa fréquence peut 
être changée en tapant la nouvelle fréquence dans le champ réservé à cet effet, ou bien elle peut 
être décalée au point suivant ou précédant en cliquant sur les boutons « + » ou « - » placés au-
dessus.

La bande balayée peut être centrée sur le marqueur courant  en cliquant sur  Mark →  Cent la 
modification prendra effet au prochain Restart.

Si les marqueurs L et R ont été placés, le balayage peut être modifié pour commencer à L et finir à 
R en cliquant sur Expand L → R. Si L est absent, il sera considéré comme étant à la limite extrême 
basse. Si R est absent, il sera considéré comme étant à la limite extrême haute.

6 marqueurs numérotés de 1 à 6 sont polyvalents. Les marqueurs L et R peuvent aussi être placés 
à votre gré et ont quelquefois une signification particulière (comme dans le cas  Expand L → R). 
Deux marqueurs spéciaux, P+ et P-, sont automatiquement placés aux fréquences des valeurs la 
plus haute et la plus basse. Leurs positions sont remises à jour à la fin de chaque balayage, à 
moins que l'option Rafraîchissement de l'Ecran à Chaque Balayage ne soit pas validée (dans la 
fenêtre des Paramètres de Balayage), auquel cas le rafraîchissement n'aura lieu qu'au prochain 
appui sur Halt.

La fréquence de chaque marqueur et les valeurs qui lui correspondent sont affichées dans la Zone 
d'Information Marqueurs, sous le graphe, qui est remise à jour à la fin de chaque balayage même 
si l'option Rafraîchissement de l'Ecran à Chaque Balayage n'est pas validée. Seuls les marqueurs 
P+ et P- ne seront pas remis à jour, dans ce cas, jusqu'à l'appui sur Halt.

Le  menu  Options  →  Marqueurs ouvre  une  fenêtre  qui  permet  de  contrôler  l'affichage  des 
marqueurs. Même si ceux-ci ne sont pas affichés, la zone d'informations est  présente sous le 
graphe. Cette fenêtre permet également de faire un usage particulier des marqueurs L et R. Ils 
peuvent en effet limiter la plage de fréquences où les marqueurs P+ et P- apparaîtront. L et R 
peuvent aussi être placés automatiquement 3 dB au-dessus et au-dessous de P+ et P-.



Changer l'apparence du graphe

Plusieurs éléments de l'apparence du graphe peuvent être modifiés :

1 –  Le nombre de divisions de l'axe des fréquences. Précisez ce nombre dans la fenêtre des 
paramètres de balayage. Pour  modifier  le  nombre de graduations verticales,  ouvrez l'une des 
fenêtres des axes Y en double-cliquant à l'extérieur de l'axe Y, et entrez le nombre de graduations.

2 – La couleur et l'épaisseur des traces peuvent être définies dans les fenêtres des axes Y.

3 – Un style de trace peut également être défini dans les fenêtres des axes Y : Off le désactive. 
Norm Erase dessine la trace comme une ligne et efface la ligne précédente au fur et à mesure. 
Norm Stick dessine la trace comme une ligne mais n'efface pas les lignes précédentes.  Histo 
Erase et Histo Stick sont similaires, mais dessinent une barre verticale à chaque pas au lieu d'une 
ligne continue reliant les points successifs.

4 – La combinaison d'ensemble des couleurs du graphique se choisit dans la fenêtre Paramètres 
de Balayage sous Apparence du Graphe. On y trouve deux choix prédéfinis, mais l'utilisateur peut 
en  créer  d'autres  comme  décrit  plus  loin.  Changer  la  sélection  dans  Apparence  du  Graphe 
remplacera tout choix précédent de couleur de trace, mais on peut rétablir ces choix comme décrit 
plus haut.

Création de nouvelles apparences graphiques

1 – Ouvrez Options → Apparences

2 – Cochez les cases pour choisir vos nouvelles couleurs. L'échantillon montre le résultat.

3 – La permanence de vos choix est hiérarchisée :

a)  Si vous cliquez sur le bouton Use, les nouvelles couleurs seront affectées au graphique 
courant jusqu'à ce que vous les changiez. Une fois changées, il ne vous sera pas possible 
de les retrouver en tant que groupe ; elles devront être modifiées individuellement.

b)  Si vous cliquez sur le bouton Save as Preset (Sauver comme Pré-réglage), une fenêtre 
s'ouvrira  qui  vous  permettra  de  sauver  votre  groupe  de  couleurs  sous  un  nom  qui 
apparaîtra dans la boîte de dialogue Apparence du Graphe dans la fenêtre Paramètres de 
Balayage. Cela vous permet de changer l'apparence et de revenir à la précédente.

c)  Quelle que soit l'option que vous choisirez, une fois le programme quitté, votre nouvelle 
présentation  disparaîtra,  à  moins  que  vous  ne  la  sauviez  dans  un  nouveau  fichier 
préférences par File → Save Prefs. Dans ce cas, au prochain démarrage du programme, 
vous retrouverez votre présentation, et si vous l'avez enregistrée comme pré-réglage, vous 
la retrouverez dans la boîte de dialogue Apparence du Graphe.



Sauvegarde et Chargement des Préférences

Au démarrage, le logiciel du MSA charge un fichier de préférences nommé Prefs.txt, qui détermine 
le mode de fonctionnement (analyseur de spectre, VNA en transmission ou VNA en réflexion) ainsi 
que la plupart des réglages des fenêtres Paramètres de Balayage et axes Y. Après avoir changé 
ces  réglages,  vous  pouvez  sauvegarder  les  nouveaux  dans  un  fichier  préférences  par 
File     →     Save     Prefs  .  Vous pouvez remplacer le fichier existant ou sauvegarder sous un nouveau 
nom.

Vous pouvez charger un fichier de préférences à n'importe quel moment par  File     →     Load     Prefs  , 
qui vous permet de choisir le fichier à charger. Vous pouvez, de cette façon, charger un fichier que 
vous aviez sauvé sous un autre nom, ou recharger Prefs.txt pour annuler les changements que 
vous venez d'effectuer.

Save Prefs et Load Prefs peuvent ainsi être utilisés pour passer facilement d'une configuration à 
une  autre  en  les  sauvant  sous  des  noms  explicites.  Souvenez-vous  seulement  que  si  le 
changement de fichier inclut les filtres video ou de résolution, vous devrez changer ces derniers 
manuellement, le logiciel ne pouvant effectuer seul cette commutation.



Lignes de référence

Des lignes de référence peuvent être créées dans tous les modes. Elles peuvent être soit affichées 
sur le graphique, soit combinées avec les données par addition ou soustraction. On y accède par 
le menu Options → Lignes de référence. Cet élément de menu ouvre une fenêtre qui vous permet 
de préciser le type, la couleur, l'épaisseur des lignes (si elles doivent être dessinées) et à quels 
axes elles seront affectées. Une ligne de référence peut être créée pour chaque axe, mais si l'on 
en crée deux, elles devront être du même type. Les types de lignes sont décrits ci-dessous.

Références «     Valeur fixe     »  
Une ligne de ce type est créée en le sélectionnant et en entrant la valeur pour l'axe correspondant. 
Par exemple, si une valeur de -18 est tapée, une ligne horizontale à -18 sera tracée sur l'axe 
choisi,  à  condition que l'option graphique « Data and ref » soit  cochée.  Cette  option valide  le 
dessin du graphe et des références. Au lieu de cela, vous pourriez effectuer une addition ou une 
soustraction  avec  les  lignes  de  référence  en  sélectionnant  l'option  appropriée  dans  « Graph 
Option ». Supposons que  votre graphique comporte un maximum à -18 dBm, et que vous créez 
une référence à -18 dBm. En réglant « Graph Option » sur « Data - Ref », la valeur de la référence 
sera soustraite de celles de la courbe, de sorte que le maximum apparaîtra à 0 dBm et que toutes 
les autres valeurs se trouveront référencées (en dBc) par rapport à ce maximum (bien que l'axe 
reste gradué en dBm).

Données sauvegardées comme référence
Vous pouvez sauver les données courantes comme référence. Cela vous permet de comparer vos 
données actuelles avec celles issues de balayages futurs, visuellement ou en les soustrayant les 
unes des autres. Si vous ré-ouvrez la fenêtre Reference Line (ligne de référence) alors que vous 
avez déjà défini une référence (tout en gardant le même type), à la fermeture de cette fenêtre, 
vous aurez le choix entre la mise à jour des données et la conservation des données précédentes. 
Exemple :  vous  voulez changer  la  couleur  du  tracé,  mais  à  la  fermeture  de  la  fenêtre,  vous 
souhaitez conserver les valeurs représentées. Ce sont les valeurs « sous-jacentes » en dBm qui 
sont sauvegardées. Ces valeurs sont converties dans l'unité indiquée sur votre graphique avant 
d'être utilisées. Si, par exemple, le graphique représente le niveau du signal en Volts, les valeurs 
de S11 sauvées dans le fichier seront converties en Volts avant d'être représentées, additionnées 
ou soustraites.

Les lignes de référence sont des objets temporaires. Elles sont conçues pour une utilisation à 
court terme. Elles ne sont pas sauvegardées dans les fichiers Préférences ou Test Setups. Si vous 
modifiez les paramètres de la gamme de fréquences, les « Saved Data Reference » (Données 
sauvegardées comme référence) disparaîtront, mais les « Fixed Value References » (Références 
« Valeur fixe ») seront conservées.



Générateur de tracking

Le mode analyseur de spectre sert à effectuer l'analyse spectrale de signaux externes. Grâce à un 
générateur de tracking (TG), le MSA peut produire un signal à la fréquence sur laquelle il  est 
accordé.  En faisant  passer ce signal  au travers d'un circuit  que l'on souhaite tester,  on peut 
mesurer sa réponse en fréquence. Cela transforme le MSA en analyseur de réseaux, même si 
n'ayant pas la capacité de mesurer le déphasage, il sera un analyseur scalaire (SNA) plutôt que 
vectoriel (VNA).

Le MSA muni de son générateur de tracking peut être utilisé aussi bien en mode SNA que VNA. 
Ces modes sont décrits dans le « VNA Operating Guide ». Toutefois, le MSA dispose également 
d'un  mode  analyseur  de  spectre  associé  à  son  générateur  de  tracking  (SA +  TG),  dont  la 
description  va  suivre.  Ce  mode  est  quasiment  le  même  qu'en  SNA,  mais  sans  étalonnage 
automatique. Supposez que vous souhaitiez analyser la réponse en fréquence d'un filtre en mode 
SA + TG. Vous commencez par mesurer le niveau de sortie du générateur de tracking (TG) ; la 
bande de fréquences est supposée assez étroite pour que le niveau du générateur soit considéré 
comme constant. Vous analysez ensuite la réponse du filtre et corrigez mentalement les mesures 
pour tenir compte du niveau du TG. Si par exemple, le niveau de sortie du TG est -10 dBm et que 
le  filtre  montre  un  maximum à  -12  dBm,  vous  savez  que  la  réponse  réelle  du  filtre  à  cette 
fréquence est -2 dBm. Un SNA ou VNA, au moyen d'un étalonnage, ferait automatiquement cette 
correction.

Très souvent, l'utilisateur ne s'intéresse pas au niveau absolu du maximum, mais seulement à 
l'ensemble de la courbe de réponse, le maximum étant pris pour référence. Par exemple, pour 
déterminer les points à -3dB, il n'est pas nécessaire de connaître le niveau de sortie du TG, car ce 
qui nous intéresse est la réponse en fréquence relative au maximum. Le mode SA + TG est parfait 
dans ce cas.

En mode SA + TG, le générateur de tracking du MSA est doté de deux fonctions particulièrement 
utiles pour l'analyse des circuits de réception :

1 –  TG offset. Dans la fenêtre Paramètres de Balayage, vous pouvez définir une fréquence de 
décalage  (offset).  La  fréquence  de  sortie  du  TG sera  égale  à  la  fréquence  d'accord  plus  le 
décalage. Ceci permet d'exciter un mélangeur à une fréquence pendant que l'on observe le signal 
à la fréquence intermédiaire.

2 – TG reverse. Dans la fenêtre Paramètres de Balayage, vous pouvez forcer le TG à « scanner à 
l'envers ». Ceci signifie que pendant que la fréquence d'accord du MSA balaie la bande de bas en 
haut, le générateur balaie de haut en bas. Cette fonction est utile pour analyser les circuits FI qui 
inversent la bande.



Observation des harmoniques

Pour visualiser un signal et ses harmoniques, vous devez effectuer un balayage normal avec un 
pas  suffisamment  fin  pour  ne  « passer  au-dessus »  d'aucun  harmonique.  On  y  parvient  en 
adoptant soit un pas très fin (d'où un grand nombre de pas par balayage), soit une largeur assez 
grande de la bande passante du filtre de résolution (filtre FI  final).  Une alternative consiste à 
démarrer  le  balayage à la  fréquence fondamentale et  à rendre le  pas égal  à cette fréquence 
fondamentale. En utilisant le style de tracé « Histo Erase », vous obtiendrez une sorte de « bar 
graph » indiquant le niveau de la fondamentale et de chacun des harmoniques.

Déterminez le rang de l'harmonique le plus élevé que vous voulez observer (la fondamentale sera 
le rang 1). Appelez ce nombre H. Soit F la fréquence fondamentale.

– La fréquence de départ est F
– La fréquence d'arrêt est H x F (il est facile de prendre H = 10)
– le nombre de pas est H – 1 (H - 1 pas correspondent à H points)

Ceci placera la fondamentale sur l'axe Y gauche, le « Hième » harmonique sur l'axe Y droit, et 
chaque pas sur le fréquence exacte des harmoniques. Si vous voulez augmenter le nombre de 
pas, prenez un multiple entier de H – 1.

Pour démarrer le balayage à zéro, réglez la fréquence de départ à 0 et choisissez H pas ou un 
multiple de H.

L’original de ce texte est disponible à l’adresse

http://www.wetterlin.org/sam/SA/Operation/SA_Guide.pdf

L’intégralité des manuels et didacticiels sont accessibles à l’adresse

http://www.wetterlin.org/sam/

Le contenu de ce texte ne peut être modifié sans l’autorisation de son auteur. Traduction f1hsu sous Creative Commons


